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Introduction to Mantid

The Mantid project provides a framework that supports high-performance computing and
visualization of scientific data. Mantid has been created to manipulate and analyse neutron
and muon data, but could be applied to many other techniques. The framework is open
source and supported on multiple target platforms (Windows, Linux, Mac). Tailor made
data reduction and analysis procedures can be formulated using Python scripting. However,
this tutorial focuses on the reduction and analysis of Muon data collected from any of the
ISIS muon instruments via a Graphical User Interface (GUI). This interface has been

specifically designed to guide the user through the data reduction and analysis procedure.

NB: this Introduction and all subsequent workshop instruction is based on Mantid : Version

3.1.0. All procedures have been tested using the Windows 7 installation.

Mantid can be downloaded from,

http://download.mantidproject.org/

and all the data used for the tutorials can be found as a downloadable ZIP file at:

www.isis.stfc.ac.uk/groups/muons/downloads/

For reliability choose the ‘Latest Stable Build’. However, as the interface is developing
rapidly, the ‘Nightly Development Build’ may contain additional features and bug fixes that

are useful for data analysis. The accompanying Wiki,

http://www.mantidproject.org/Main Page

contains a wealth of information and supplementary information regarding the Mantid
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Getting Started

The worked examples presented in this workshop will be analysed using a GUI. This GUI is
launched by following: Interfaces > Muon Analysis from the tool bar at the top of the main
MantidPlot window. NOTE: the manual Mantid 4 * will be referred to throughout. Make

sure you have a copy

4 Launch the main Mantid interface by clicking on the MantidPlot icon on the desktop

Home | Grouping Options | Settings | Data Analysis I Results Table

Instrument

Time Zero: (us) 0.2
EMU -
First Good Data: (ps) 0.3 (measured from Time Zera)

Dead Time Tables: [Nnne v]

Description:
Data Files

Detector Grouping

Group [ Group Pair: [

Data collected in <n> Periods, Plot/analyse Period:

Plot Data
Ptepe: [ ]

Run Information

Connected: NfA Manage Directories

1. The Muon Analysis window
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|. Setting data file locations

Before starting you should ensure that Mantid is configured for your needs. In particular you should
add paths to directories which contain the worked example data. All the data used in this
workbook can be found in folder Desktop > Reference Material. To set this path, click on File >
Manage User Directories. The window below will appear. Data can be added as a path by browsing
or typing the directory name in the field below Data Search Directories and then clicking Add

Directory. Once a path has been added, data stored in that location can be accessed simply by

entering the run number.

4+ set paths for your raw data and working directories

¥ Manage User Directori

! Data Search Directories | Python Script Directories | !
Data Search Directories
C:\Users\mt29'\Desktop\Reference Material Browse To Directory
Search Data Archive
Default Save Directory
e

[ Cancel H oK ]

2. The Manage User Directories window
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Il. QtiPlot

Enabling QtiPlot allows data sets and workspaces to be analysed using a suite of inbuilt

Origin fitting algorithms. To enable QtiPlot follow View > Preferences > Fitting. The following

window should appear. Select Enable QtiPlot Fitting

# MantidPlot - Choose default settings @
— | Fitting |
F :l General
[] Enable QtiFlot fitting
- Generated Fit Curve
M Mantid -
() Uniform X Function
@ Same X as Fitting Data
Tables
@ Display Peak Curves for Multi-peak Fits
Peaks Color [ green -
i
Parameters Output
Significant Digits g
3D Plots
Write Parameters to Result Log
[] Paste Parameters to Plot
Fitting Scale Errors with sqrt{Chi~2{doF)
T ) o) [t

3. The Choose Default Settings window

When QtiPlot fitting has been enabled, and a data file has been loaded, Analysis appears in

the list of options above the main MantidPlot window toolbar.

¥ MantidPlot - untitled
File Edit View Graph Data Analysis Format Windows [Interfaces Catalog  Help

DErR2ReER | Ok =2 =2&7
_ MS Shell Dig 2 0 ElB ru x* x

Results Log

—
AsymmetryCalc started

AsymmetryCalc successful, Duration 0,00 seconds
AsymmetryCalc started

AsymmetryCalc successful, Duration 0,00 seconds

4. Tool bar options at the top of MantidPlot. Analysis appears when QtiPlot is enabled

Mark Telling May 2014 -




S MUON DATA ANALYSIS

Training School 2014

The fitting options that will appear under Analysis are shown below

File Edit View Graph Data [Analysis | Format Windows Interfaces Catalog Help

DRERRRRE  of=w s AES
f—————————— Integrate
1 HE B ity < x
b |3 Integrate Function...
ts Log
= F Smooth 3
AsymmetryCalc started
AsymmetryCalc successful, Duration 0 FFT filter 3
AsymmetryCalc started
AsymmetryCalc successful, Duration 0 Interpolate ...

Fit Linear

Fit Polynomial ...

Fit Expanential Decay
Fit Exponential Growth ...

Fit Boltzmann (Sigmoidal)

Fit Gaussian

Fit Lorentzian

Fit Wizard...

5. The QtiPlot analysis options

# Ensure QtiPlot is enabled
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Basic Mantid Data Manipulation

In this section you will:

familiarise yourself with the content of Mantid workspaces

learn how to examine histograms

learn how to read / export data

learn how to overlay data / change plot style

|. Basic LOAD Command Workspaces

Mantid utilises workspaces to hold data. These come in several forms, but the most
common is the Matrix Workspace which represents XYE data for one, or several, spectra.
The data contained in a workspace can viewed as a matrix or as a table, and graphed in
many ways including line graphs, contour plots and 3D graphs. Interaction with workspaces
is typically through a GUI interface. Matrix Workspaces are typically created by executing
one of Mantid's 'Load' algorithms or are the output of algorithms which take a Matrix
Workspace as input. In addition to data, workspaces hold a workspace history which lists

the algorithms that have been applied to the data.

First we will load a raw data file WITHOUT USING the Mantid Analysis GUIl and examine its

content:

+ In the MantidPlot ‘Workspaces’ pane(see Fig 6) use the LOAD button to import file
HIFI00062798.nxs
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4+ Click on the ‘arrow’ beside the file name - this allows information about the format of
data file to be viewed. The following should be seen in the Workspace List pane to

the right of the screen.

Worl [

‘ Load Group

-

Workspaces

4 [ HIFI00062798
Workspace2D
Title: 4 0.0

X : Time | microsecond

Y axis: Counts

Instrument: HIFI (1900-)an-31 to 2100-Jan-31)
Memory used: 3 MB

6. The workspace list window

We find that a workspace called HIFI00062798 is created and ...

e isa2Darray

e the data has been collected from a silver calibration measurement taken in a
transverse field of 20G

e it contains 64 spectra (or histograms i.e. one for each HiFi detector),

e There are 2048 time channels, or bins, per plot

However, the NeXuS format allows a lot more information be stored in a data file than that

listed above. As an example,

4+ right click on the file name and select ‘Sample Logs’. A list of experiment and
instrument parameters that have been logged during a measurement, from

magnetic fields to sample temperatures, appears.
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¥ MantidPlot - HIFID0062798 ssmple logs (2] = J
Name ) Type Vaue  Units »| [importselectediog| [ dlose |

Temp_SP num. series (79e Fiter log values by
Temp_Sample um. series (79e A
Temp_Power num, series (17e.. =l @ None
Temp_P num. series (17e... _
Temp_MaxPower num. series (17e © Status

L Temp_1 um. series (17e ) Period
Temp_D num. series (17e.. _
Temp_Cryostat num. series (79e... @ Status +Period
Steer_VSM2 um. series (17e
Steer_VSM1 num, series (17e.. Log Statistics
Steer_Septum num. series (17e... -
Steer_HSM num. series (17e :
Status str. series (2ent Max:
Slits num. series (6 ent..
run_title string agT=... Mean:
run_start string 2013
run_number string 62795 Time Avg:
run_end string 2013-.. Median:
nspectra numeric &4
MUSR_Orientation str. series (Zent 5td Dev:
MUSR._Field num, series (17e..
1515 beam num. series (Zent.
ICPEVENT sir. series (12e i
18 ™ rum_sari fia

7. The Sample Logs window

To interrogate any of these logs double click on the ‘Name’.

4+ Examine Temp_Cryostat —the plot below should appear. Explore other parameter files

| B —TL e 11" *
' Graphd - =E

450 —

Temp

—— Temp-Cryostat (2013-Nov-18 14:33:44)3_Cryostat

350

300

Cryostat

250
200 H

150

oy
-100 o0 100 200 300 400
o Time (sec)

T T T T L

8. A plot of log file entry Temp_Cryostat

As mentioned, since we have simply loaded HIFI00062798.nxs, workspace, HIFI00062798
holds within it raw positron counts / bin for EACH individual HiFi detector. To examine the
data collected in a single detector, right click on HIFI00062798 and select Plot Spectrum. The

following input fields appear.
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Enter Spectra IDs: 1-64

10

Or
Enter Workspace Indices: 0-63

[ ok || cancel || Potar |

9. Raw data plotting options

On HiFi, as way of example, there are 64 detectors hence ID numbers: 1-64 (1-32 =

upstream detectors, 33-64 = downstream detectors.

4+ Enter a detector (ID) number of your choice and click OK to plot the associated raw

data.

For information:

e ARGUS has 192 detectors (usually pre-grouped to 32 histograms in the data analysis
software)

e MuSR and HIFI have 64 detectors (usually pre-grouped to 32 histograms in the data
analysis software)

e EMu has 96 detectors (usually pre-grouped to 32 histograms in the data analysis

software)

The raw positions counts / us for detector 10 are shown below. Alternatively, entering

'5,10,20' plots spectra 5,10 and 20 on one graph
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TSR |
Workspace HIFIDDD62798 Workspace HIFIDD0D62798
1,200 — 1,200 —

—— HIFI000627598-5p-10 — HIFI00062758-sp-5
4 — HIFI00062798-sp-10
—— HIFI00062798-sp-20

1,000 1,000
800 —|

600 —

Counts

400 —

200 —

T T T -t T T
10 15 20 -5 a 5 10 15 20 25 30 35
Time | microsecond Time | microsecond

10. Raw data (counts / us) collected in HiFi detector no. 10 (left) and in detectors 5,10,20
(right)

ll. Exporting Data

To export the data contained within any listed workspace click on the Algorithms tab at the
bottom of the workspace list pane. The options shown below should appear. Select

SaveAscii from the dropdown menu (beside Execute) and click Execute.

The SaveAscii Input Dialog box should appear. Select a directory (for the written data file)
and specify a file name. The workspace to be exported can be selected from the dropdown
list next to InputWorkspace. The user can also, for example, define which workspace spectra
i.e. indices (Min and Max) to export, choose the type of data separator used in the file (CSV

is usually a reliable option), add comments and decide whether to WriteXError.

4+ Export spectra 4 and 5 as directed above. Ensure you can read the written data file

using some other plotting package
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Algorithms a8 X

Algorithms
Arithmetic
CorrectionFunctions
Crystal
DataHanding
Deprecated
Diagnostic
Disgnostics
Diffraction
Events
Inelastic
MDAlgorithms
Muan
Optimization
PythonAlgorithms
Reflectometry
SANS
Sample

[ Transforms

b Utility

[ Workfiow

VYV VUVYYYEVVYVVVY

v

Algarithms Workspaces

11. The Algorithms options

.

|Sa\res a 20 workspace to a asdi file.

InputiWorkspace  |HIFID0062798 |

Filename c:\templexported_data.dat

WorkspaceIndexMin 4

WorkspaceIndexMax 5
SpectrumList
Precision

[ wiriteXError

CommentIndicator Exported Data

Separator [Space -
ColumnHeader

12. The SaveAscii dialog box
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[ll. Overlaying Data

To overlay data, select the plot window in which you wish to compare data. Right click on
the plot window and select Add/Remove Curve. A list of available data sets will appear. As
an example, in the figure below we have the option of adding the data contained in the
workspaces HIFI00062798-sp-10 and HIFIO0062798-sp-45 to the plot window of
HIFI00062798-sp-10. To do so, first select the two spectra in the left hand pane and then

click the ‘right’ pointing arrow. Reversing this process removes data from a plot window.

4 Create two plots — one showing data from detector 10 and one showing detector 45

4 MantidPlot - Add/Remove curves - ’ ‘ M

Available data Graph contents
HIFID0052798-sp-10 B | | HIFI00062798-5p-10 Plot Assodations. ..
HIFI00062798-sp-45
<] Edit Range...
Edit Function...
[ Show Range

[] show current folder only

13. Add / Remove Curves options window

4+ Overlay the data from detector 45 on the data from detector 10
The plot style (line, scatter, line + scatter etc) of the changed by double clicking on the plot
window and selecting the required data set. The axis settings can be changed by double

clicking on the x- or y- axis and entering new limits

4 Familiarise yourself with changing plot styles/colours as well as axis limits
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Basics Of Data Reduction

This section explains:

. the concept of t,ero and tgpoq

. the concept of dead time correction

. how to set the detector calibration factor, o
. how to group data

NOTE: detailed information about functionality contained under the Mantid Analysis GUI TABS -
Home, Grouping Options, Settings, Data Analysis and Results Table — will be referred to and can be

found in the hand-out Mantid 4 p*

NOTE: from now on we will load data using the Muon Analysis interface

l. the concept of t,ero and tgood

Although the timing origin for the muon response in the sample is when the middle of the
muon pulse has reached the sample, the good data region is not obtained until the entire
pulse has arrived at the sample. This time is defined as tg04. to ON the other hand is the time
at which the middle of the muon pulse reaching the sample. The difference between tgooq

and tg is referred to as the tgooq offset-

When using the Muon Analysis GUI, t,ero and tgeoq are loaded from the NeXusS file having
been determined by the instrument scientist (NB: you will determine t,,, from
experimental data later on) However, for the purpose of demonstration, we will aim to

broadly determine these parameters from the raw data and see how they compare with the

Mark Telling May 2014
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tp tgood

2.0E5 | '

1.5E5
5
Q 1.0E5¢}
O

0.5ES5

0 5 10 15 20 25 30 35 40

Bin number

14. Diagram of ISIS data near the pulse showing T ;ero and T 4004

ll. the concept of dead-time

After a detector has recorded a positron count there is a small time interval before it is able
to detect another count. It is possible, especially at the high data collection rates now
available on the muon instruments, that a positron will arrive within this interval and not be
recorded. Statistical analysis can be used to correct for this. A silver sample is used to
determine dead time values for each detector, the results of which are made into a dead
time data file. The NeXuS format stores this data internally. For further information about

the correction of detector deadtime see: Kilcoyne, RAL report RAL-94-080 (1994)
To explore the effect of dead time:

#+ Load data file EMUO00034998.nxs. Make sure ‘none’ is selected for Dead Time

Mark Telling May 2014
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4 Reload the data file but select “From Data File”.

o What happens?

#+ Create a plot to show the effect

[Il. the detector calibration factor, o

The detector calibration factor, o, can be determined for any given detector pairing by

clicking on Guess Alpha (Grouping Options) and analysis of transverse field data.

#+ Using the GUI, load transverse field measurement MUSR00024563.nxs

4+ Select the Grouping Options TAB
o Notice that when you load a data file using the GUI, the default option for the
MuSR spectrometer is to GROUP (or add) all data in detectors 1-32 (a group

of detectors referred to as BCK) together. Similarly, data in detectors 33-64 (a

group called FWD) is summed.

+ To generate a, click on Guess Alpha.

o Reload the data file. What has happened?

4+ You can rename groups fwd and/or bck and/or change the detectors to be summed.

Alternatively you can create additional grouping options
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o In the Group Table, create two new grouping options with names of your
choice that add every 5™ detector (i.e.33,38,43...)

o Below ‘long’ enter a new Group Pair name for this new grouping option

4 Click ‘Guess Alpha’

4 Reload the data file BUT before you do choose your new Group Pairing option from

the Group / Group Pairing drop down list. What do you notice about alpha?
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The Basics Of Muon Data Analysis

In this section you will reduce and analyse data from a MuSR experiment to investigate the
temperature dependence of the muon spin relaxation rate. The data to be used is from a
study of spin fluctuations in the spin glass system Y(Mn,Al,) with all measurements being
collected in a longitudinal field of 110G to supress spin relaxation arising from static internal

fields. Further details can be found here: prb.aps.org/abstract/PRB/v85/i18/e184416

You will:

J build up a fit function from pre-installed models and fit data

J export and tabulate specific fits / experimental parameters

] model the dependence of said fit parameters by writing a user specific function
Data files

File Name Sample Field Temp
MUSR00024563 YMnAI TF 20G 265K
MUSR00024576 - 24590 YMnAI LF 110G 90 - 290K

(check log file)

l. fitting T20 data

Once calibration factors, detector groupings and dead times have been set, fitting the data

Mark Telling May 2014
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To get a feel for the fitting process, we will first fit a damped oscillatory depolarisation

function to the T20 measurement

 #

o+ F

Using the GUI, load run number MUSR00024563.nxs

In Grouping Options, deter

mine o

In Settings, rebin the data using a ‘step’ factor of your choice (‘step’ = an integer

value and defines the number of time bins to average over)

Choose the Data Analysis TAB.

For details about fitting refer to section 2.IV. Data Analysis in the Mantid 4 u* manual

Following the instruction in IV. Data Analysis fit the MuSR T20 data

For a = 1.22, Rebin Data > Fixed Steps > 2, Fit range > 0.1 to 10 us you should get the

plots and values shown in 15

=
¥ Muon Analysis l=l@] = |
Home | Grouping Options | Settings | Dats Analysis | Results Table |
Fit Function (Chi-sq = 2.23141)
[ Fit - Display - [ Setup -
Property value
4 Functions
Type CompositeFunction
4 f0-ExpDecayOsc
Type ExpDecayOsc
A 0.220051
Lambda 0.023298
Frequency 0.276717
phi 0.110572
NumDeriv True
4 Data
Workspace MUSROD024563; Group=long; Asym; £5
Workspace Index 0
Start () 0.100000
End {us) 10.000000
4 Settings
Minimizer Levenberg-Marquardt
Plot Difference 7] False
Fit To Raw Data ] False
- >
¥ MUSR00024563; Group=long; Asym; #5-1 s oo
¥(MnAl)2 T=260.0 F=20.0
0.3 o MUSR00024563; Group=long; Asym; £5
—— MUSRO0D24563; Group=long; Asym; #5_Warkspace-Calc
i
0.2 % 2
0.1
4
E
H
z
2
0.1
-0.2
03 T T T T
0 2 4 6 8 10
Time | microsecond

15.

Result of fitting MUSR00024563 to ExpDecayOsc
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An aside - Workspaces created using the Mantid Analysis GUI

When a data file is loaded, as an example MUSR00024563.nxs, a top level workspace called,
in this case, MUSRSR00024563 is created. Clicking on the side arrow shows the contents of

this workspace — namely:

e MUSR00024563 ; Grouping —long ; Asym # 1
e MUSR00024563 ; Grouping —long ; Asym #1_Raw

As can be seen in the figure below, the data in these two sub-workspaces is raw data re-
binned in steps of 10 and the raw, un-binned, data respectively. Both workspaces are Asym

plots and have had Detector Grouping > Long (sum of detectors 1-32 and 33-64) applied

¥ MUSROD024583; Group=long; Asym; #1-1 [=[8] = ]

Y(MnAI)2 T=260.0 F=20.0

—=— MUSR00024563; Group=long; Asym; #1

Home | GroupingOptions | Settings | Data Analysis | Results Table

Data Plot Style

Line +Symbol -
Start at First Good Data -

st [0.11

Minimum: (/2 imu A Autoscale
Show error bars

b Inelastic
b MDA

> Muon

b Optimization

b Pythonalgorithms

Data Binning

Data collected with histogram bins of 0.0159999 ps
> Reflectometry

» Ranots
Rebin data: Steps: 10
o v

> Sample L9

4 5
Time [ microsecond

& x
¥ MUSRO0U4563; Grovp=long: Asym 1Rawl
Gow ot~
p=long; Asym; #1_Raw
0.4 > Anal
> [l MuonAnalysisGrouped
—— MUSRD0024563; Group=long; Asym; %1 Ran 4 [ MUSR00024563
- B oy,
0.3 » B TUSR0002456 3; Group:
02
H
Eoid
<
o]
(2] connected: MUSRO0024563; Groun=long; Asym; 51
0.1
] & x
B i s e e e e e e B e LA Name Tvpe View Size Created Label
0 2 s 10

Muon Analysis Custom window Normal 0. 1k8 31/01/2014 14:08:05
- Normal 0.1k 31/01/2014 14:11:28
Normal 0.1k 31/01/2014 14:11:41

+ 6
Time / microsecond PEMUSR00024563; Grouy

[Prlusroon24se3; Grou

16. Result of fitting MUSR00024563 to ExpDecayOsc
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Once a fit has been performed, however, the contents of workspace MUSR00024563 are modified

such that three new levels are created. Fitting the T20 data again as an example, we get workspaces:

. MUSR00024563 ; Grouping —long ; Asym #1_NormalisedCovarianceMatrix

o MUSR00024563 ; Grouping —long ; Asym # 1 _Parameters

. MUSR00024563 ; Grouping —long ; Asym #1_Workspace

Again, clicking allows the type and basic contents of the workspaces to be viewed

¥ MUSR00024563; Group=long; Asym; #1-1

[o[@] = ]

Asymmetry

—+— MUSRO0024563; Group=long; Asym; #1
—— MUSR00024563; Group=long; Asym; #1_Workspace-Calc
—— MUSR00024563; Group=long; Asym; #1_Workspace Diff

Y(MnAI2 T=260.0 F=20.0

¥ MUSR00024563; Group=long; Asym; #1-Raw-1

pa

Asymmetry
L

—— MUSR00024563; Group=long; Asym; ¥1_Ran

p=long; Asym; #1_Raw

4 6
Time [ microsecond

Data Analysis

Home | Grouping Options

Settings

Results Table

Algorithms

-

Fit Function (Chi-sq = 8.69013)

[ Fit

o |

Display =] Setp

=)

Tipe

NumDeriy
4 fo-ExpDecayOsc
Type
A
Lambda
Frequency
Phi
4 Data
Workspace
Workspace Index
Start (us)
End (s}

Minimizer
Plot Difference
Fit To Raw Data

CompositeFunction

[ Falee.

ExpDecayOsc
0.223277
0.026532
0.276681
-0.113107

MUSR00024563; Group=long; Asym; #1
[

0.100000

10.000000

Levenberg-Marquardt
True
[ False

|| |Property Value

Algarithms

b Arithmetic

> CorrectionFunctions
b Crystal

> DataHanding
> Diagnostics

> Dffraction

b Events

> Inglastic

b MDAlgorithms
> Muon

» Optimization
> PythonAlgarithms
b Quantification
> Refiectometry
b Remote

> SANS

b SING

> Sample

b Transforms

> Uity

I

Workspaces

[ oad <] [ Delete Group

[ sat ~]

8 x

Warkspaces

> B8 Muonanalysis
> Bl MuonAnalysisGrouped

4 [Bm MUSR00024563

> [l MUSRO0024563; Group=long; Asym; #1
> B MUSR00024563; Group=long; Asym; #1_Ran

> [ MUSR00024563; Group=long; Asym; #1_NormalisedCovaria

> B MUSR00024563; Group=long; Asym; #1_Parameters
> [ MUSR00024563; Group=long; Asym; =1 Workspace

8 x

17. Result of fitting MUSR00024563 to ExpDecayOsc

Name
Muon Analysis

[EMUSR00024563; Group=long; Asym; #1-1  Graph

Type View Size  Created
Custom window Normal 0.1K8 31/01/2014 14:08:05
Normal 0.1kB 31/01/2014 14:21:52

Label

The most useful workspace to view is - MUSRO00***** - Grouping — long ; Asym #

1_Workspace — which contains the data, fit and residual. To view all in one plot, right click,

select Plot Spectrum and enter ‘0-2’ (0 = ID for data, 1 = ID for fit, 2 = ID for residual)

Il. Temperature dependence of the muon spin depolarisation
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Next we will investigate the temperature dependence of the u* spin depolarisation rate, A.
a. Fitting the data

First, we need to gauge the percentage of asymmetry that is attributed to instrumental

background (which we will assume to be time independent)

#+ Load data file MUSR00024576.nxs (YMnAl sample at 90K)

+ Build a function that models both the spin depolarisation and a flat background. Use

o Functions > Add Function > Muon > StretchExpMuon

o Functions > Add Function > Background > FlatBackground

#+ Fit the data and fix the resulting background level

4+ Next determine a value for full t=0 asymmetry. For this, load data file
MUSR00024590.nxs (YMnAIl sample at 280K)

#+ Fix Beta = 1, refit the data and fix parameter A for all subsequent fits

+ Finally, un-tie Beta and fit all the data between 100K and 280K using the Fit >

Sequential Fitting option.

o Note another way to fit the data is to first read in all the data files between
100 and 280K (24580 — 24590). Each time a file is read an associated
workspace is created

o Once all files are loaded, set up your fit function, follow Data Analysis > Data
> Workspace and select the file to analyse from the drop down menu.

o NB: as the run logs will show, the temperature does not increase linearly so

Mark Telling May 2014
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[ Load V][ Delete Group

Workspaces

- B MuonAnalysis

> Bl MuonanalysisGrouped
> B MUSRD0024563
> [By MUSRO00D24575
> [ MUSRO0024576
> [By MUSRO0024577
> [ MUSRO0024573
> [y MUSRO00D24579
> By MUSRO00D24580
» [y MUSRO0D24581
> [By MUSRO0D24552
» [y MUSRO0D24583
> [By MUSRO0D24554
> [By MUSRO00D24585
> [By MUSRO0D24586
> [BW MUSRO00D24587

> [By MUSRO0D24588
> [y MUSRO0D24589
> [By MUSRO0D24520

F X

18. Workspaces created after reading in all raw data files

b. Exporting and plotting parameters

To tabulate, and plot a specific fit parameter, as a function of some experimental factor use
the functionality found under Results Table. The Results Table TAB lists all workspaces that
have fitted data associated with them, as well as all logged experimental parameters —

temp, magnetic field, pressure etc.

Note: you may notice that some entries under Fitting Results > Individual Fits have different
colours. Different colours delineate between data sets that are the same but were fitted
using different functions i.e. they have different parameter sets. For example, in Fig 19,
MUSR00024575 has been fitted with first a stretched exponential and background (black

entries) AND THEN just a stretched exponential (red entry)
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Fitting Results

Fit Table Name Include |+

]

1 MUSRO0024563; Group=long; Asym; #1

=

2 MUSRO0Q024575; Group=long; Asym; #1

m

=

3 MUSRO0024575; Group=long; Asym; 2

=

4 MUSRO0024576; Group=long; Asym; %1

=
[

5 MUSRO0024577; Group=long; Asym; #1

=

& MUSRO0024578; Group=long; Asym; #1

=

7 MUSR0O0024579; Group=long; Asym; #1

Select/Deselect Al

Table

Name: ResultsTable Create Table
\

19. Files with different fit parameters are delineated by different colours

No matter if you use Individual file or Sequential file fitting, in the Log Value box
select the experimental parameter you want to be written out to accompany the fit
parameters - in this case check Sample_Temp

Tick all the data workspace files in the Fitting Results (box BAR 24563 - the T20
measurement - if you fitted files individually)

Enter a name for your fit parameter table

Click Create Table — a table should appear as should the associated workspace
Select columns Sample_Temp (X) and f(0).Lambda(Y) in the fit parameter table
Right click and select Plot > Scatter

To add error bars, click on the graph to activate it.

From the main MantidPlot toolbar select Graph > Add Error Bars

Select Source Of Errors > Existing Column and use the drop down menu to select
fO0.LambdaError

The result should look something like >
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==l . = h
¥ Table-1 - YMnAl_Stretched_Plus_Bck_Fit_Parameters ||| Muan Analysis Sl eze]
Run Number| | Temp_Sample[X] | fo.AM fo.AErrorY] | fo.Lambdal¥] fo.LamboaErrorM ™o T~ Grouping Options | Settings | Datm Anlysis | Results Table I
0 0194243 ‘
1 0.134243 Values E
2 0194243 Log Value Indlude - E
3 0194243 18 Templ F
a ERH 0194243 0.139735
5 0194243 0.0711697 20 | Temp_MaPower
6 0194243 0.0573183 = 3
21 Temp P b
7 0194243 0.0379365
8 0194243 00350785 . 22 | Temp_Power
) 0134243 0.0226784 25 beanlog_current E
0134243 0.0160402 . L
0.134243] 0.527865 ! 24 beamlog_freq
0.184243 . - 25 ISIS beam =
0194243 0.171419 !
0.134243] 0. 0.0130202 I 26 Temp_Sample
2 fi
Select/Deselect Al
Fitting Results
I
Fit Table Name Include -
25 1 MUSRO0024563; Group=long; Asym; #1
1 L) ®  Table-1_fo.Lambda '
E - 2 MUSRD0024575; Group=long; Asym; 1 L |
2 1 3 MUSRDO0024576; Group=long; Asym; #1 I
1 4 MUSRO0024577; Group=long; Asym; #1 I
4 5 MUSRO0024578; Group=long; Asym; #1 I
1.5
o
2 & MUSRO002457%; Group=long; Asym; #1 I
=
ER - 7 MUSRD0024580; Group=long; Asym; %1 I
-
] 8 MUSRO0024581; Group=long; Asym; #1 I
] |
] Select/Deselect All |
0.5 - - |
. - Table I
1 N Name: YMnaAl_Stretched_Plus_Bek_Fit_Parameters Create Table |
0 *L + » . s » |
————— %
50 100 150 250
X Aoxis Title
[ IFizeanka Granh Hidden N 1LR 21/11/2014 1A:3A:47

20. Result of fitting MUSR00024576 -90 using ExpDecayMuon +FlatBackground

c. Writing functions to fit parameters

Finally we are going to fit a critical form to A(T) vs. T, namely

to extract a glass transition temp, Tg, and a critical exponent, y

To code and fit a user defined function in Mantid:
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+ If the x-axis data in the table does not increase linearly then re-sort the data. To do
this, select Sample_Temp, right click on the column and select Sort Table

4+ Choose options:

o Sort columns > together
o Order > ascending

o Leading column > -Sample_Temp

4+ Click OK and the temperature axis should now be in ascending order accompanied by
associated depolarisation rates

Re-plot the graph and click on it to activate the plot window

Select Analysis from the main MantidPlot tool bar

Select Fit Wizard

Select Category > User defined

Enter a name for your new function

FF FFFEF

Enter the equation into the blank input field. For example, y=mx+c might be coded:

o Name: Linear Fit
o Parameters:m, c

o Entry on equation field: (m*x)+c

4+ Save the file and click on Fit to launch the Fit Wizard dialogue box
%+ Click Fit — this launches the fit control dialogue box below. Using the parameters

shown in Fig 21 should give the fit in green (Note: Fit from 90K to 280K)
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' Table-1- YMnAl_Stretched_Plus_Bck_Fit_Parameters

-:-—-El-u

0.194243
0.194243
0.194243
0.194243
0.194243
0.194243
0.194243
0.194243
111.095 0.194243

e @ N SN AW N RS

120.252 0.194243
0.194243
0.194243
0.194243
0.194243
0.194243

Run Mumber[ ITellm—Sarﬂ f.AY] 0. AErrar[yEr im.l.mﬂﬂjﬂl.l.ﬂlildﬁni fo.BetalY]  f0.BetaError| f1.AD[Y] fL.ADError[yl Cost function value| Cost function valueEr

W] o.0smss|  0.4s3Eiz) ooveess| 0027745 0 vossss [

OPLPNE  0.662291 00054653  0.027746 0 113147 0

0596991 0.00484631 0027746 0 1.03991 0

0.376035 0.00443837 0027746 0 110713 0

0.748244) 000862271 0027746 0 112409 0

RECTEIEEE  0.76020) 00110527 0.027746 0 1,02301 0

SRS 0817697 0.0138782)  0.027746 0 1.17856 0
RO 079292 0.0209338)  0.027746 0 1.03827 0
RIS 0.830825 0.0242418)  0.027746 0 1.09803 0
AN PE|  0.783833  0.0292685  0.027746 0 1.1425 0
0.037935  0.00209 0764242 0,0344588 0027746 0 1.13384 0
GEC g TR e 0.5335%5  0.00218631)  0.027746 0 1.10623 0
0.0226784 0. "5 0.602253 0.00418871)  0.027746 0 1.05654 0
E TR 0.708877 0.0034412)  0.027746 0 1.1386 0
00130202 0. 0301957 0.0736006| 0027746 0 0933394 0

¥ MantidPlot - Fit Wizard

Curve [Table—l_ﬂJ.Larrbda

Function Test (x, L,t.@)

et a

Initial guesses

Parameter Valug

1 0.021468268

t 83,2898854

0.916519302

(]|

Algorithm lsaled Levenberg-Marguardt

Y Axis Title

Color [ [ green

From x= 90 E Iterations

Tox= 280,239 5] Tolerance

| [¢<Edtfuncton| [peleteFteurves| [ A ||

Close | [custom output >3

|@7R| ¥ Graph2 | =8 £ |
[
,] Title
0.5
#  Table-i_fo.Lambda
®  MNonlLinear17_2
—— MonLinear33_2
Constant
. ‘ 4
v] ]
v] g
1000 =
0.0001 = b
Weighting Method [Arbitrary Dataset | [Table-1 | [fo.LambdaError -
(|

21. Result of fitting A(T) vs. T using the critical form
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Instrument Calibration Examples

Now that you have the basics of data reduction and manipulation using Mantid we will

apply these techniques to analyse typical instrument calibration data.
You will :

e analyse steering curve data to determine the current needed in the
horizontal beam line steering magnets to centre the muon beam on the
sample

e create a range curve to investigate how thick a sample has to be to ensure all
muons are stopped

e analyse data to determine a value of t, for the instrument

e analyse frequency response data to determine the upper relaxation rate that

can be observed on an instrument

Example 1: the steering curve

Aim

To determine the current needed in the horizontal beam line steering magnets to ensure
the muon beam is centred at the sample position. The sample used was a 20mm Ag mask
covering Fe203 (slits 4). Fe203 rapidly depolarises the muon spin polarisation such that any

asymmetry you observe can be attributed to muons landing in the Ag mask
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Task

By fitting the data sets below using a suitable relaxation function, create a results table and

plot the initial asymmetry vs. magnet current.

Run log

44989  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 09:38:14 2013 "calibration" Current 0.00 Amp
44990 "Haematite on Ag T=295 F=100.0" Thu 5. Dec 09:44:33 2013 "calibration" Current 0.25 Amp
44991  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 09:53:12 2013 "calibration" Current 0.50 Amp
44992  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:00:58 2013 "calibration" Current 0.75 Amp
44993  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:06:06 2013 "calibration" Current 1.00 Amp
44994  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:15:26 2013 "calibration" Current -0.25 Amp
44995  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:21:13 2013 "calibration" Current -0.50 Amp
44996  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:26:53 2013 "calibration" Current -0.75 Amp
44997  "Haematite on Ag T=295 F=100.0" Thu 5. Dec 10:33:37 2013 “calibration" Current -1.00 Amps
Tip

4+ The steering magnet current is not logged on EMu. When you view your Results
Table, enter the current values by modifying the RunNumber column NOTE you may

have to change the column from Read Only before you can enter the currents

Example two: the range curve

Aim

If a sample is too thin then the muon’s momentum will carry it straight through the

material. On the other hand, if the material in front of the sample (i.e. mylar attached to a
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sample holder or perhaps the beam windows on a cryostat) is too thick then the muon may
not have enough energy to pass and reach the sample. To ensure muons thermalize in the
sample, the instrument scientist needs to know the density required to stop the particles.

This information is determined via a range curve

Task

Fit the data sets below using a suitable relaxation function, create a results table and plot

the initial asymmetry vs. number of Ti foils

+ Determine how many foils are needed before none of the muons land in the quartz

+ From this value, determine the density (in mg/cmz) required to stop all muons

Run log

18888 Quartz sample with 0 Titanium foils in front
18889 Quartz sample with 0 Titanium foils in front
18890 Quartz sample with 1 Titanium foils in front
18891 Quartz sample with 2 Titanium foils in front
18892  Quartz sample with 3 Titanium foils in front
18893  Quartz sample with 4 Titanium foils in front
18894  Quartz sample with 5 Titanium foils in front
18895 Quartz sample with 6 Titanium foils in front
18896  Quartz sample with 7 Titanium foils in front
18897  Quartz sample with 8 Titanium foils in front
18898 Quartz sample with 9 Titanium foils in front
18899  Quartz sample with 10 Titanium foils in front

Density of Ti : 4.5 g.cm'3
Thickness of foils: 30 um
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Example three: determining tg

Aim

Using transverse field calibration data from a silver sample, you will determine a value of tg
for the EMu spectrometer. If tg is correct the phase of the TF oscillation should be field

independent.
Task

Guess an initial value for to (suggestion use 0.3 ps). Fit the data sets below using a suitable
relaxation function, create a results table and plot the phase of the oscillation (in rads) vs.

muon Larmor frequency (in rads/sec)

+ Useful pointers:

o once you have fitted the first data set, fix Apand A
o ensure you fit over the same time range for all data sets
o make sure that the frequency value you get equates to the field applied

O v, =13.6 kHz/gauss and remember to convert to radians

%+ |s the phase field independent?

+ The gradient of the rate of muon Larmor phase (in rads ) vs. change of applied field
(in rads.sec) gives the amount by which to adjust your initial toguess

+ Find the gradient, adjust your to guess and refit a few data points between 20 and

100 G to ensure that phi is constant (within error)
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Run log

18850  Agsample with Transverse Field = 20 Gauss
18851  Agsample with 40
18852  Agsample with 60
18853  Agsample with 80
18854  Agsample with 100
18855  Agsample with 10
18856  Agsample with 30
18857  Agsample with 50
18858 Agsample with 70
18859  Agsample with 90
18860 Agsample with 5
18861  Agsample with 15
18862  Agsample with 25
18863  Agsample with 35

Example four: frequency dependence

Aim

Using transverse field calibration data collected from a quartz sample, you will investigate

the frequency response of the EMu instrument.
Task

Fit the data sets below using a suitable relaxation function. Note: quartz has both

diamagnetic and muonium fractions which will need to be modelled
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4 Plot the precessional frequency of the muonium fraction vs. asymmetry with error
bars

4 What do you notice?

4 What is the upper resolvable frequency of the EMu spectrometer?

Run log

19626  Quartz sample with Transverse Field = 0.5 Gauss
19627 Quartz sample with Transverse Field = 1.0 Gauss
19628 Quartz sample with Transverse Field = 1.5 Gauss
19629 Quartz sample with Transverse Field = 2.0 Gauss
19630 Quartz sample with Transverse Field = 2.5 Gauss
19631 Quartz sample with Transverse Field = 3.0 Gauss
19632  Quartz sample with Transverse Field = 3.5 Gauss
19633  Quartz sample with Transverse Field = 4.0 Gauss
19634  Quartz sample with Transverse Field = 4.5 Gauss
19635 Quartz sample with Transverse Field = 5.0 Gauss
19636  Quartz sample with Transverse Field =5.5 Gauss
19637 Quartz sample with Transverse Field = 6.0 Gauss
19638 Quartz sample with Transverse Field = 6.5 Gauss
19639 Quartz sample with Transverse Field = 7.0 Gauss
19640 Quartz sample with Transverse Field = 7.5 Gauss
19641  Quartz sample with Transverse Field = 8.0 Gauss
19642  Quartz sample with Transverse Field = 8.5 Gauss
19643  Quartz sample with Transverse Field = 9.0 Gauss
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Appendix I:

a bit about acquisition and data formats

Currently the muon instruments use two different acquisition systems:

a) MACS/EXP - hybrid Windows/Linux system as used on ARGUS
EXP MACS
Graphical User Interface
Event by Event Data Teslflnpl;i:gﬁ : Ig:]:et:ol
ARGUS NIM érigger logic Slgfﬁg%gﬁsﬁgs:“m Ondine/Off-line muSR Analysis
Spectrometer G ﬁ CAMAC Crate ‘ for event by event data

DAQ Commands MACS

Sl —
PAW
i —

Packed Histograms

EXP Windows PC

Temperature Controller

SCSI

Linux PC||]

ACC (K3976)
SCSI CC (K3929)

b) SECI - Windows based control system as used on MUSR, EMU and HiFi

#ven| | Plosesim s | @e |me
pe [T rere— Ty o ]

- R

Once a run has ended the saved data is stored in the following locations on the ISIS network:
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HIFI \\hifi\data\hifi00010000.nxs

EMU \\emu\data\emu00010000.nxs

MUSR \\musr\data\musr00010000.nxs

ARGUS \\ndw656\macs\nexus\argus0010000.nxs

All muon data at ISIS is NOW stored in NeXuS format (nexusformat.org) however older RAL
binary format (.ral) data still exists. A typical run file size is 200-600 kb but data compression

can reduce the size by up to a factor of 7
SECI data format NeXus-1: hierarchical, extendable format (.nxs), soon Nexus-2

MACS data format  Nexus-2 (.nxs) plus RAL binary format (.ral)

The NeXuS data format itself is based on the NCSA Hierarchical Data Format (HDF,

hdfgroup.org) and is comprised of three components:
1. Aset of subroutines to make it easy to read and write NeXus files
2. Aset of design principles to help people understand what is in them

3. Aset of instrument definitions to allow development of portable analysis software

— . Runll01 (NXentry) —|[ sample (NXsample)

_ counts
_Ifi monitor (.\IXITRUII!EUI)E 7 time_of_{flight
= integral
“u/ data (NXdata)
_; start_time
— 1'7 Runl102 (NXentry) _||“) sample (NXsample)

— H monitor (NXmonitor)

ISIS NeXus muon definitions can be found at: www.isis.stfc.ac.uk/groups/muons/downloads
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